FIaShJeSter Flashjester FAQ. @

the ultimate place for flashing tools

1. What is the minimum | need to fill in to be able to build my screen saver?

To make full use of the program, we suggest you fill in all the fields. However, if it is a quick start you
are after, you will need to fill in the following fields:

Company Name
Long Name

Short Name

Flash Projector File
Setup Box Graphic
Build Path

Filling in any less than this will cause your screen saver not to be built.

2. What tools does Creator include?

The tools included can perform many tasks. As well as creating a screen saver from your projector files,
Creator can make a totally customisable setup box. Once your screen saver has then been made, you can
package it up using Creator's built-in install maker.

3. What is Creator?

Creator takes your projector files made in Macromedia Flash and turns them into screen savers.
However, unlike many other screen saver creation programs, there is no need to leave the program.
Creator includes all the tools you need to create, package up and distribute in one program.

4. | have a bitmap at the start of my screen saver. When the screen saver loads up, the animation
for this bitmap is slow. Is there anything | can do about this?

The screen saver takes a little time to load the whole projector file at the start. To combat this, you will
either need to put in some empty frames at the beginning or use as little vectors/graphics at the start as
possible. It should only take a few seconds to load but it is best to leave a short delay before the
animation starts.

5. When | put the web, e-mail and other labels on my setup box they don't show up. Why?

Ok. This simple mistake has been made by a few people and is VERY simple to get around. What has
happened is you have put the labels on the transparency colour, not the bitmap. The bitmap is the only
part that will show when the screen saver is built, so al labels will need to be placed over this. When
designing your setup box bitmap, it isagood ideato leave room for your labels.

6. In my screen saver, it loads separate SWFs onto the different layers. This all works fine apart
from the SWF at the start. This does not load up. Why is this and how can | combat it?

Thisis quite ssmple. What is happening is that for the first and maybe second frame of the projector file,
Creator is extracting all the files used in the screen saver. So when you call for the SWF, it has not been
unpacked yet. You can solve this simply by loading the SWF on the second or third frame.

7. What if | don't pick an icon?
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The default Creator icon will be used.

8. Can | use any bitmap for the setup box?

Y es. Creator supports bitmaps of up to 256 colours but if you have a 16 million colour bitmap you wish
to use, Creator will optimiseit in 256 colours.

9. How customisable is the setup box?

Using a graphic, the setup box will form itself round the picture making a totally unique shape to each
bitmap used. Once the shape has been defined, you can select from a list of components to put in the
setup box including aweb link, e-mail link, sound mute control, interaction control and midi file sound
control.

10. What if I want to use my own install maker?

When Creator builds the screen saver it creates two folders, install and screen saver. Install contains the
install file with the screen saver inside. The screen saver folder contains just the screen saver. You can
use your own install maker here.

11. What about the install maker?

Creator can package your screen saver up before you leave the program. You can edit al the dialogue
boxes that appear as well as the background of the installer. You can display a bitmap or gradient
background, you can change the main bitmap in the dialogue boxes, you can include and exclude
dialogue boxes and do many more things.

12. Will my screensavers run on Win ME/2000/XP ?

Only if you have version v.1.2. If you don't then you will need to upgrade to the latest version. The best
thing about thisisthat the upgrade is FREE.

13. Is it possible to build screen savers for use on the MAC OS platform?

No, sorry. It's a completely different ball game. We don't have the skill or resources to port to the Mac,
well not at the moment, anyway. We suggest you use ScreenTime for the Mac and ours for the PC
version. Spot the difference !!

14. What's the minimum spec | need to run Creator ?

A minimum spec for Creator is any Pentium machine, 16MB RAM, 3MB Drive space,
WIN/95/98/NT/ME/2000/X P

15. I am trying to use JWeb to add a link to a URL from within a screensaver file | built with Creator.

I am using FlashMX, and when | go through Creator and build the install file, then install it and click
the link, | get this message:
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Error no URL defined

First you must use JStart and not JWeb in order to launch web pages, due to the security in NT. We have
written code to overcome this problem in JStart.

To create the command to paste into the FLA you MUST use Jugglor and the JTools section in there.
JHelpor will not work.

Detailed instructions.

1. In order to create a projector with a link to a live URL, that can be converted to a screensaver, you
need the following: Flash, Creator, Jstart, Jugglor

2. With Flash, you create your FLA file. In your FLA file, you will need a button, to launch the URL.

3. You'll need to create some code with Jugglor, to paste into your button Action window. If you open
Jugglor (you can download a 30 day free trial) and launch the program, go to the JTools section.

4. From the JTools section, click on Jstart, and enter in your URL and error message. If you are using
FlashM X, make sure the FlashM X checkbox is selected and then click the Copy button.

5. Go back to your flash file, and select your button. In the Actions window, select fscommand, then put
Exec in the first field, and paste in what you just copied, into the second field (this is assuming you are
using Normal Mode for your Actions window).

6. Save your FLA file. Publish your FLA file as a Windows Projector.

7. Quit Flash and Jugglor. Launch Creator. Follow the directions for importing your EXE (projector)
file. When you get to the screen to add additiona files, you'll need to manually add a JSTART .exefile -
thisisincluded in the C:\Program Files\FlashJester\JT ool s\Source\ folder on your Cdrive.

8. Proceed through the Creator screens and Build your screensaver That should do it.

Please |ook at the example file provided.

16. Where can | get cool midi files from for free?

Just pop on over to http://www.exrock.com. There's a lot there for you to use! And tell them the Jester
sent you.

17. Can | have both the Flash music file and the midi file playing at the same time?
Yes. You can play both or one or the other.

18. Can | use ANY flash projector file?
Yes, only PC versions though.

19. Does the screen saver support password protection?
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Yes

20. Why should | choose the FlashJester Entertainor?
The FlashJester Entertainor is one of the best Flash screen saver players about and has many different
features that are not in others. The FlashJester Entertainor allows you to add interaction to the screen
saver. By turning on the interaction, you can point and click at the screen saver. You can also turn the
sound to the Flash file on or off. By turning it off, you can also add another great feature to the screen
saver, playing amidi. The screen saver allows you to play any midi file along with the screen saver.

21. | have a few questions regarding installers. First, which specific WISE installer to you
recommend? Package Studio? Wise for Windows Installer? or Wise Installation System? Are they
all flavors of the same product? Are there any other less robust solutions that you might
recommend? For now, all | really need to do is create a simple installer that allows the option to
‘Launch at Startup'. I'm sure WISE products can do this but | have no need for its many other
functions.
OK See the attachment. We've just created a ssimple Installation for you using the Wizard. It will install a
Juggled filein ac:\program files\pitball directory and add alink in the Startup directory as you required.

We recommend you go for the

Wise Installation System 9 - Standard Edition
Thisisvery powerful asitis.
http://www.wise.com/ordercentermain3.asp?category=6

We use an old version of Wise Install. It does the job and alot more.

22. | have a bitmap at the start of my Juggled file. When the Juggled file loads up, the animation for
this bitmap is slow. Is there anything | can do about this?

The Juggled file takes a little time to load the whole projector file at the start. To combat this, you will
either need to put in some empty frames at the beginning or use as little vectors/graphics at the start as
possible. It should only take a few seconds to load but it is best to leave a short delay before the
animation starts.

23. Can the user control how the animation is played?

That depends if you have the keyboard interaction on or not. If the keyboard interaction is turned on, the
user will be able to start and stop the animation by pressing the Enter button. They can also go forward
and backwards through the frames by pressing the left and right buttons. If you turn keyboard interaction
off though, these keys will not function.

24. What about my screensaver? Won't that interrupt it?

One of the options of Jugglor isthat you can choose to disable the screen saver while the Juggled file is
playing. This can be done in the Flash Settings section.
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25. Do the users need the Flash Shockwave plugin to view the Juggled file?

No. This is the beauty of Jugglor. You don't need any plugins at all as Jugglor uses Projector files,
stand-alone programs in themselves, to create the Juggled files.

26. What files will | need to include with the file?

Y ou don't need to include any files with the finished Juggled file since everything is packaged up in the
one EXE.

27. 1 have a lot of SWF movies which | load in using the Load Movie command. If | add them all into
the additional files section then the file is way too big and takes ages to load. Is there any way | can
get around this?

Yes. You do not haveto put al your moviesinto the Juggled file. By using Jugglor's " Current Directory”

feature (in the build section), you can specify the directory in which the Juggled file will look for the
movies

28. | want to be able to secure some of the files that are inside my Juggled file, as when they are
extracted anyone can acess them from the Windows/Temp. So | am looking to secure it using
Winzip. | have JStart and Jugglor. Now how can | extract/uncompress a password protected Winzip
file ?

In Winzip you can use command line to extract compressed files see

>>
Extracting Files
The command format is:

winzip32 -e [options| filename].zip] folder
where -eisrequired.

options

-0 and -j stand for "Overwrite existing files without prompting” and "Junk pathnames’, respectively.
Unless -j is specified, folder information is used. Use -sPassword to specify a case-sensitive password.
The password can be enclosed in quotes, for example, -s" Secret Password".

filename.zip
Specifies the name of the Zip file involved. Be sure to specify the full filename (including the folder).

folder
|sthe name of the folder to which the files are extracted. If the folder does not exist it is created.

>>
The above was taken from

http://www.winzip.com/xcmdline.htm

With JStart you can pass these parameter oni.e

File
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winzip32

Arguments
-e -s'flashjester” jstart.zip

where

the password is flashjester
jstart.zip isthe zip file inside the Juggled file

Remember the zip file will uncompress into the Windows/Temp where all the other file are.

Please download the working example and then build the project in Jugglor to see it working.

29. I'm using Jugglor and JSave together, and when | tell JSave to save to the text file the text file is
not there when | look. Where is it?

When you run a Juggled file, it extracts all the files and JTools it uses to a temporary directory. When
you run Save, it saves the text file to that directory. If you wish to save it in the directory in which you

run the Juggled file from you will need to use the LOCAL% Command. To find out more about the
LOCAL% command look at the

JSave Help file -> Setting up JSave - Additional Commands

30. | can save text using JSave with Flash MX projector files ?
Yesyou can. You will have to use JSave and Jugglor together in order to do this.

Remember to look at the ActionScript very carefully and don't forget to add the EncodeForJugglor
function. YOU MUST ADD THIS.

Please download the example file to get a better understanding.

31. I'm using Jugglor and JSave together, and when | tell JSave to save to the text file the text file is
not there when | look. Where is it?

When you run a Juggled file, it extracts all the files and JTools it uses to a temporary directory. When
you run Save, it saves the text file to that directory. If you wish to save it in the directory in which you

run the Juggled file from you will need to use the LOCAL% Command. To find out more about the
LOCAL% command look at the

JSave Help file -> Setting up JSave - Additional Commands

32. Are they compatible with a Juggled file?

The JTools and Jugglor are best companions. By using the two, you can come up with a fully
functioning piece of software.
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33. What if | want to have more that one web/email/program link?

You'll only need to include one copy of each JTool you use as the parameters inserted in the Projector
file reuse these JTools. These are to be kept in the same directory as the projector file.

34. 1 am now using Flash MX/6 Projector files, but none of my previous JTools link work ? Why is
this ?
Yes, this will not work due to the changes made by Macromedia in Flash MX. You will need to
recreated the links by pressing the Copy button again in the Jtools section and paste accordingly into the
FLA file and exporting it back as a Flash MX/6 projector file. Remember you will not need create the
FSCOMMAND directory for the JTools to work, Jugglor has taken care of this.

35. For FSCOMMAND - Exec to work with Flash MX, | heard you have to create a FSCOMMAND
directory ? Is that true ?

If you are using Jugglor and the JTools then you don't need to create the FSCOMMAND directory. If
you are not then yes you will need to create the FSCOMMAND directories yourself. Please see
respective helps.

36. | have Flash MX on my machine but | want to create a Flash 5 projector. How can | do this
without reinstalling Flash 5 ?

First make sure you have Flash 5 on the machine. Then locate
\Program Files\M acromedia\Flash 5\Players\FlashPla.exe

Open it and then close it. This will set the Flash 5 Player as default. Click on an exported Flash 5 SWF
file from Flash MX and now it will open up the Flash 5 player. Then go to File -? Create Projector. Now
if you would like to create a Flash MX Projector just use the Publish command and check Window
Projector checkbox.

37. Why doesn't the Patch command work with Flash MX files ?
Y ou don't need to patch Flash MX files. We are using a different approach here.

38. | want to run an AVI file but | don't like the default Microsoft AVI player. What should | do?

Weéll, if you have your own AVI playing program you can use JStart to get that to play your AVI. You
can however use our specially designed JAvi player. This will play an AVI file with the minimum
amount of effort. JAvi is totally customisable, with features including looping the AVI, closing when
finished playing, one instance and many more.

39. My Auvi plays from JAvi fine on one machine, but doesn't on another | tested it on?

Thisis probably due to the codec that you have encoded your Avi in and it is not installed on the other
machine.

40. Can JAvi detect whether a codec is installed?
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The JAvi play cannot currently do this, but we are looking into it for the next version.

41. Is there any way | can include all the files in one EXE rather than distribute the AVIs, JAVI and
projector together?
Yes there is. You can use another product in the FlashJester range, Jugglor. With Jugglor, you can
modify how your projector file plays and acts, but the feature that you will find most useful is the fact
that you can have al your files, JTools and projector files in the one EXE. A free evaluation version of
Jugglor can be found on the FlashJester website at http://www.jugglor.com.

For an example of Jugglor and AVI combined, check out the JAVI Example file included with this
installation of JAVI. If you want to see how this works then have alook at the JAVI Example file FLA.
There you will see al the links and how they work, and if you want to know how those links were setup
in JHelpor, the JHF is there as well.

42. How do | get JEmail working with Flash MX ??
See exampl e below.

43. Why is the text in the copy box in JHelpor different to the text that is inserted in the FSCommand
box when | press CTRL + V?

The reason for this is because JHelpor works out the actual code needed for the JTool. As the projector
file doesn't accept spaces what you see in the Argument box is the code with the spaces. JHelpor then
modifies this to take out all the spaces.

44. Will 1 have to include a copy of JMovie for each movie file | open with it with Flash 5?

No. JMovie works with parameters meaning that you don't need to make copies, it will just use the one
copy to run al your links. In Flash MX you will have to create one instance for each movie you use. The
best thing will be to use Jugglor and JMovie then you will only need one copy of JMovie.

45. Is there any way | can include all the files in one EXE rather than distribute the movie files,
JMovie and projector together?
Yes there is. You can use another product in the FlashJester range, Jugglor. With Jugglor, you can
modify how your projector file plays and acts, but the feature that you will find most useful is the fact
that you can have all your files, JTools and projector file in the one EXE. A free evaluation version of
Jugglor can be found on the FlashJester website at www.jugglor.com.

For an example of Jugglor and a movie file combined, check out the IMovie Example file included with
this installation of JMovie. If you want to see how this works then have a look at the IMovie Example
file FLA. There you will see all the links and how they work, and if you want to know how those links
were setup in JHelpor, the JHF is there as well.

46. Do | need JHelpor to set up JNetCheck links, the same as your other tools?

No, not at the moment. This is because you only need to simply run JNetCheck and do not need any
parameters to make it work. In the future, it may be necessary because of added features.
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47. 1 have JNetCheck set up, but what can | do with it?

Take alook at the Uses section of this help file and the example file that comes packaged as well. Try
experimenting with it also and if you come up with any good examples, let us know. Email
galery@flashjester.com with your examples.

48. I'm looking into creating a CD that would contain a Flash projector file on it. On one frame of the
file, it would contain a print button, that would print the contents of the frame to a PDF file. Do you
have a tool that would accomplish this?

Y ou can create the PDF files you need from the Flash file and save the save indivdua psf file then use
JStart to print the pdf file.

Look at the help file

C:\Program Files\FlashJester\JT ools

JStart_ IWeb JEmail.hlp -> JTool Settings -> JStart -Using the Print Command

or

Y ou will need a PDF Printer Driver.

Here one

http://www.pdf995.com/

yu can find more by going to

http://www.google.com/search?sourcei d=navclient& ie=UTF-8& oe=UTF-8& g=PDF+Printer+Driver
Basically you use the normal print command in Flash or you can use

JPrintor
http://jprintor.flashjester.com

and instead of printing to a Printer you select this PDF driver.

49. Will I have to include a copy of JPrintor each time | want to use it in my projector file?

No. JPrintor works with parameters meaning that you don't need to make copies, it will just use the one
copy to run all your links.

50. What if the user doesn't have a printer?
JPrintor will not print if the user does not have a printer.

51. How do | use JSave with Jugglor with Flash 5?
JSave can be used with Jugglor in the same way that all JTools are set up. See the Jugglor help file for
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more information on setting up JTools.

52. What does all this coding mean?
To find out more about the coding used in the Flash file, have alook at the Flash manual or help file.

53. | have followed the steps in the step by step guide but it still won't save. What can | do?

Copy the "Save" keyframe over again, and make sure you replace EVERY Memol with your own
choice of variable for your text box.

54. | have tried typing into the text box but it only takes my first line | type. Why's this?

JSave only takes the first line you insert into the text file and will not take any characters after you have
pressed return.

55. | have typed in a long paragraph but it got cut off half way through. Is there a limit to the amount
of words you can type and save?

Yes. Flash is limited to just exporting 255 characters (this is even less taking into consideration the
JSave command and the parameters for where the text file will be stored.)

56. Because the Flash file is in Flash format, does that mean | will need to patch it as | have had to
with other JTools?

No, you won't have to. The special coding ensures that is not needed for JSave.

57. I'm using Jugglor and JSave together, and when | tell JSave to save to the text file the text file is
not there when I look. Where is it?

When you run a Juggled file, it extracts al the files and JTools it uses to a temporary directory. When
you run Save, it saves the text file to that directory. If you wish to save it in the directory in which you

run the Juggled file from you will need to use the LOCAL% Command. To find out more about the
LOCAL% command look at the

JSave Help file -> Setting up JSave - Additional Commands

58. Where can | get Jugglor from?

You can download a free evaluation version of Jugglor from the FlashJester website at
http://www.jugglor.com.

59. Am | limited to certain shapes?
No, not really. It's up to your imagination and Flash.

60. Why can | see bits hanging around my Juggled file?
Thisis caused by discolorisation of the transparent color, probably due to when it was decreased from 16
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million colours. You can easily get rid of this by adjusting the tolerance control in the main JShapor
window.

61. Why have the Border, Caption and Size options been disabled in my Juggled file when | add a
JShapor command?

These are disabled because the skin you choose specifies the size and you will not need the borders and
captions because of the custom shape.

62. We need to launch Excel files out of the projector. The master
CD works fine on my machine (winXP), but is erroring on WinME
and win98 cpus. The projector launches Excel okay, but cannot
find the files despite loading the application.

Here is a sample ini file.

[START]
Application=../Excel Files/cash flow projection.xls

Y ou are using fowardslash / when you are suppose to use backward slash \
So it should be

[START]
Application=..\Excel Files\cash flow projection.xls

63. | have a Flash MX projector file that uses the LOADMOVIE command to load additional SWF
files. Now | want these SWF files to load my Word, Pdf, EXE and other files. Is this possible ?

Y es, you can sure thisis possible.

Please download and carefully look the example file given.

64. Does the final flash file need to be an EXE for the JISTART commands to work or will an SWF
also work?

Yes it has to be a Projector file, it will not work on SWF files in a browswer due to security reasons,
unless you are using the LOADMOVIE command to load additional SWF files from a projector file. See
the FAQ above this one for more details.

65. | want the desk.cpl file (Display Properties) to launch when I click on a button in my movie. Is this
possible ?

Yessure. You will need to write the following
[START]

Application=rundl|32.exe
Parameters=shel|32.dll,Control_RunDLL desk.cpl
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Please see the example file below.

66. How can | open a file Maximised or Minimised when it has been launched ?

JStart allows you to open any file Maximized or Minimized. i.e Word Documents, PDF's, PowerPoint
file etc. All you need to do is specify the name of the file you want to print in the File box then add the

[/startmaximized - to Maximize
/startminimized - to Minimize
command in the Argument Box
Download the example file provided.

67. How can | automatically print a pdf file ?
JStart allows you to print any file that supports DDE printing. i.e Word Documents, PDF's, PowerPoint

file etc. All you need to do is specify the name of the file you want to print in the File box then add the
/print command in the Argument Box
P ease download the examplefile.

68. Can you show me how to use JStart to launch a browser that has links to files on my CD-ROM ?
See the exampl e file below.

69. How do | print a text file within a Flash Projector file on Win95/98/NT/ME/2000/XP ?
Using JTools - JStart.
1. Start JHelpor.
2. Pressthe Add command +
3. Select JStart from thelist of JTools available.
4. Select Use Parameters.
5. Under the heading 'File' write
For Win 95/98 machines.
WIN%\write.exe
For Win NT

SY S%\write.exe
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Y ou will have to create 2 different buttons

Click hereto print if you are using Win 95/98 and
Click hereto print if you areusing Win NT

if you can't determine what Operating System the user has.
6. Under the heading 'Arguments’ write
yourtextfile.txt /p /close

where yourtextfile.txt is the name of YOUR text file, Remember to keep it in the same directory as the
projector file. Otherwise different if you know where the text fileis.

/p prints the text file
/close closes write.exe

7. Optional, enter an Error Message something like,
"Whoops cannot print text file'

8. Press OK

9. Then the preview button to seeit in action.

10. If you are happy with the results then press the Copy button and then when in your *.fla copy the text
into the Arguments section using the FSCOMMAND , Exec.

70. Why do | need to use JWeb when | can use

getURL("http://www.flashjester.com”)

?
The advantages of using JWeb rather than GetUrl, is that

1. It will work on all Windows operating systems.

2. The browser window will always appear on top of the projector file and not behind it.
3. Each link you load up will open in the same browser window.

4. It'sFREE.

71. Does JWeb support the POST command?
No, you will have to use the POST command in GETURL in Flash.
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72. | have Flash and the web and e-mail links work fine when | create a projector file. Why do | need
JWeb and JEmail?

JWeb and JEmail's intended use was with Flash 3, as the projector files created in there had the web and
e-mail links disabled. JWeb and JEmail do also however work with Flash 4 or 5 if you so wish to use
them. One of the advantages of using JEmail for you e-mail links is that you can also specify the subject
of the e-mail.

Something which you might have also have found between the two versions of Flash is that the projector
file player is actually alot bigger than its predecessor adding around 100kb more. If you are not using the
extra features in Flash 4 or 5, then it is advisable that you use Flash 3 and the JTools as each JTool is
only 20kb in size and you only need one copy of each no matter how many links you create using them.

73. How do | delete the Shockwave/JPEG/ Real audio files from my cache after | have view/copied
them?

The browsers will automatically clear files in cache after a certain amount of time, but with Woof you
can choose to delete these files. To do this, you must first search you desired path for the file type of
your choice. When the files are listed, you can use the check boxes at the side to choose which ones you
wish to delete. Once you have selected them, either right click on your mouse and select delete from the
menu that appears or go to the file menu and select delete.

Also, after you have copied some files, Woof will then ask you if you wish to delete these. Selecting Yes
will delete them from the folder you copied them from. Selecting No will return you back to the list not
deleting any files.

74. Does Woof display Flash 3, 4 and 5 files?
Yes, it will display all flash files, no matter what version.

75. When | finish surfing the web, | load up Woof to copy the Shockwave files | have viewed online
to another director. However, when | search for them, they are not all there. Why does this happen?

When you browse the web, all the internet documents, images, Shockwave movies etc. are stored in the
temporary internet folders on your harddrive (cache). The maximum size that these folders can be are
defined by the internet browser. If it goes over this amount, it starts to delete old temporary internet files.
So, if you find that not all the Shockwave files that you view online are being kept, perhaps your
browser has set the size of the cache folder to quite a small size. You can ssimply change this by going
into the browser's properties and changing the size of these cache folders. Another, more simple way to
get round this is to use Woof just after you have viewed a Shockwave file. This will almost guarantee it
will still be in cache.

76. This preview window is too small to see the Shockwave in detail. Can | view it larger?

Yes you can. The point of the preview window is just so you get a rough idea of what the Shockwave
movie looks like. To view the Shockwave in a large window, right click on the desired Shockwave
movie, and select open. Thiswill then open the Shockwave in the Flash Shockwave Player.

77. Do you issue an invoice that | can use officially in my country ?
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Yes, sure you can. You will be able to print the invoice online when you register the product. Look out
for Print Invoice option.

78. What services do you offer?
We offer the Creator Express Service which involves putting together your screen saver. Y ou send us the

Projector File and the graphic for the setup box and we'll do the rest. We will convert it to a screen saver
using your graphic to make a custom designed and shaped setup box. Thiswill then be packaged up in a
setup file all ready for distribution. You can get al this for just $99! Y ou will be free to distribute your
screen saver as many times as you want. Y ou will also get a massive $100 discount on Creator which is
<a href="http://flashjester.com/services/creatorexpress/index.htm">Click here for more info.</a>

79. | can save text using JSave with Flash MX projector files ?

Yesyou can. You will have to use JSave and Jugglor together in order to do this.

Remember to look at the ActionScript very carefully and don't forget to add the EncodeForJugglor
function. YOU MUST ADD THIS.

Also DO NOT USE underscores in your filenames.

Please download the example file to get a better understanding.

80. Can JWeb and Jugglor work together ?
Can | make JWeb dynamic ?

Y es sure you can.

<a  href="http://www.flashjester.com/?section=fag& cPath=14 22">Click here  for  further
information</a>

81. I need help in using JWeb with Flash MX.
Please download the following JWeb example.

82. How do | save multi line text using JSave and Jugglor in MX ?
See the example below.

83. Why do | need to use JMapi when | can use JEmail of free ?
Well simple.
It allows you to do more than JEmail does.
1. Allows you to send attachments.

2. Works with ALL email clients. i.e Outlook, Outlook Express, Lotus Notes, Eudora and Netscape
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Mail. JEmail doesn't work too well with Lotus Notes.
3. Support Line breaks.

4. Much more stable.

See the exampl e files provided.

:\Program Files\FlashJester\JT ool s\JM api\M X

84. All I want is to put in a carriage return so | can get a space between lines in a standard txt file,
these created txt files will be used by another program. Is there a way or a work around?

Yes, you can by using the %CR command. See JSave Help file -> Setting up JSave -> Additional
Commandsi.e %LOCAL, %TIME, %DATE for moreinfo.

Please download the examplefile.

85. How can | open a new window like a popup from a Flash file inside a html file ?
Vigit... http://www.flash-db.com/PopUp/

Create the window with the features you want or don't want!, generate the code, and ssimply copy &
paste the generated code on your Flash button. No html stuff envolved here. Everything's in the Flash
movie.

86. How far back has Windows Media Player been packaged with the windows operating
system(win95, win98, win2k)? Does JMOVIE only work with certain versions of Windows Media
Player?

WMP - Windows Media Player comes with all the Windows operating systems.
JMovieisdesigned and will work with any WMP version, including the one

used on Win95. In the end, it will work even without WMP installed, then
it will usethe old MCl interface. Some features may work not so well then.

87. What is the difference between the Standard and Pro version ?

Creator Standard
Create an unlimited number of screensavers but you can only distribute 10,000 of each screensaver you
create.

Creator Pro
Create and distribute an unlimited number of screensavers

88. | have a Flash file which uses the FSCOMMAND - AllowScale=False.

How can | make my movie files fixed within the Flash area on all resolutions ?
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Y ou will need to use IMovie and Jugglor together for this.
JMovie -> Position Size -> Relative to Flash - Checked

JMovie -> Position Size -> Fixed flash size - Checked -> Enter in the size of the Flash file - Width x
Height

Please download the example source file to see how thisis achieved.

89. Is there are way to convert swf to fla ?
Look at

ASV
http://buraks.com/asv/index.html

90. | think | have an old version of the stand alon Flash Projector player. If there is - where can | find
it?
Y es sure go to the Macromedia site

http://www.macromedia.com/support/flash/downl oads.html

91. | want the HTML out of the Juggled Projector while still being able to link to AVIs, PDFs, and PP
outside of the Juggled Projector and to not need FlashPlayer installed on the user's machine. Is this
possible?

1. Download Jugglor from www.jugglor.com

2. Create the new JStart link in Jugglor - JTools

3. Select "Use parameters’

4. In the File box type LOCAL%MYHTMLFILE.HTM. This declares the html to be opened.

5. Copy and paste the command into the Flash FLA file.

6. Export the SWF and then patch it (Jugglor - JTools - Patch Movie).

7. Create a Projector file and assign thisin Jugglor - Flash Details - Flash Projector file

8. When you press build it will compile ONE Juggled file containing JStart and the Projector file. So all

you have to do is distribute onefile.

9. Make the links to PDFs, AVI's etc. in the html files have no paths just the files name and maybe a

subdirectory if you can created one.

We recommend you download the sample file from

92. 1. | want to launch the cdplayer.exe in Win98/2000 ... or the wmplayer.exe
in WinXP with the same Button in a Flash projector application with JStart.

2. | want to start from a Flash projector file located in the data-section
of a CD-Extra the Audio-Tracks in the audio section of this CD.
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Can you tell me which commands for jstart | have to create.

And at least: How can | avoid the error messages, when the apllication (e.g.
wmplayer.exe) indicated in a Jstart command does not exist on PC?

We suggest you just specify the name of the *.cdafile on your CD. This will
load the audio track with the default CD Player it has been assigned to.
Thiswill be the best option
See examplefile.
93. Do you have JWeb for the Mac?
No we don't and you don't need it. Y ou can use AppleScript
See
tell application "Finder"
open location "http://www.myurl.com"
end tell
Read the posting on FlashKit forums if you need more information.

http://www.flashkit.com/board/search.php?& action=showresul ts& searchid=941512

94. How do | save a text file to a floppy disk?
Y ou will have to write something like this

EncodeForJugglor('lJSAVE.EXE a\\demo.txt "Textbox1="+Textbox1)
See example file provided.

NOTE: Remember that flash usesthe\ as a prefix for special characters. \n is a new-line for example. So
\ must be coded as\\. Thisis Flash, not JSave requirement.

95. How do | get access the My Application Data directory? | want to save a text file there?
Y ou can now use the new command in 1.2
AppData%
which will give you accessto
C:\Documents and Settings\UserName\Application Data folder.
Look at example file provided and please read the

JSave Help -> Setting up JSave -> Additional Commands

Page 18



FlaShJeStel' Flashjester FAQ.

the ultimate place for flashing tooils

96. How do | get access the My Documents directory? | want to save a text file there?

Y ou can now use the new command in 1.2

MY DOC%

which will give you access to

C:\Documents and Settings\UserName

Look at example file provided and please read the

JSave Help -> Setting up JSave -> Additional Commands

97. How do | get access the Shared Object Directory, where the *.sol files are saved? | want to save
a text file there?

Y ou can now use the new command in 1.2

MY SOL%

which will give you access to

C:\Documents and Settings\UserName\A pplication Data\M acromedia\Flash Player\local host
Look at example file provided and please read the

JSave Help -> Setting up JSave -> Additional Commands

98. I'm trying to get an exe to launch from a Flash MX projector file, and it's not working, did | do
something wrong here?

on (release) {
fscommand("exec", "myprojector.exe");
}

For Flash MX the exe you want to launch must be in a folder called fscommand and that folder must be
located at the same level as your original file you are calling from. The folder name is not included in the
argument however, the script stays the same as listed above.

Download the example file below.

If you want to launch other types of filesi.e word, pdf etc take alook at
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http://jstart.flashjester.com
Please take a look at the example <a

href="http://www.macromedia.com/support/flash/tsdocuments/fscommand_projectors.htm"
class=allocation target=_blank>files</a> provided and the Macromedia site.

99. How does one send data from a projector to an email without the use of an email client mucking
up your interface...?

Y ou and use PHP and Flash to send emails.
See
http://www.sephiroth.it/tutorial s/flashPHP/email/
100. Does JMapi support multiple attachments ?
Y esit's possible to have multiple attachments
Y ou have to use the following syntax
Parameter3=FI L E1<#00>FIL E2<#00>FILE3
where FILE# are the paths of thefiles.
i.e
Parameter3=C:\Temp\imagel.JPG<#00>C:\Temp\image2.JPG<#00>C:\Temp\image3.JPG
S0 just add <#00> between files.
That will do the trick.
101. Can you add HTML tags to the body of the email ?
Sure it's possible see the following example
[MAPI]
Address=support@flashjester.com
Parameters=test
Parameter2=<html><body>title : thisis a test<br><br></body></html>

Parameter3=
Error=error

102. Can you load text into the body from a text or html file ?
Yeswe've just added this into the latest version of IMapi.
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Syntax : FILE:<filepath>

Example 1

FILE:bodytext.txt

where bodytext.txt is in the fscommand directory

Example 2

FILE:. \bodytext.txt

where bodytext.txt is in the same directory as the projector file

Please look at the examplefile

103. I am using Jugglor and JMapi. | want to be able to have multiply attachments and also want to
load a text file in for the body part.

Is this possible ?
Yesitis.

Body
Syntax : FILE:<filepath>

Example 1
FILE:bodytext.txt

where bodytext.txt isinside the Juggled file

Example 2
FILE:local%bodytext.txt

where bodytext.txt isin the same directory as the Juggled file
Multiply Attachments

Y ou have to use the following syntax
FILE1<#00>FILE2<#00>FILE3

where FILE# are the paths of thefiles.

i.e

images\imagel.JPG<#00>i mages\image2.JPG<#00>image3.JPG
theini file will look like this

Parameter 3=l ocal %i mages\imagel.JPG<#00>| ocal %i mages\image2.JPG<#00>image3.JPG
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where imagel.jpg and image2.jpg are external of the Juggled file and image3.jpg isinsideit.
SO just add <#00> between files

P ease download the examplefile.

104. How can | create ICON files *.ico ?
We recommend you use

Axialis lconWorkshop
http://www.axialis.com

It's brillant.

105. Do you have JStart for the Mac ?
No because you don't need it. Y ou can use ActionScript

Read this

Create an AppleScript that opens the file and simply call the AppleScript from Flash using an
fscommand.

here is the script:
copy and paste the following into the AppleScript editor

tell application "Finder"
activate
select file "yourfile.mov" of disk "Y ourDisk"
open selection
end tell
(simply change the name and extension of the file and disk to meet your needs and leave the " ")
then save the script (i used classic applet and it worked well) as: "your_applescript”
For this solution to work correctly (simply) you need to make a disk image, name it and drop your files
inside. Be sure that the "YourDisk" string matches the exact name of the disk image you have just
created.

codein FHash:

Page 22



FlaShJeStel' Flashjester FAQ.

the ultimate place for flashing tooils

on (release) {
fscommand("exec", "

}

the AppleScript and files should be in the same folder for the sake of simplicity (once you get it
working, then you can play around with changing the location of your 'support' files and the qualified
path within the script

your_applescript");

If you want more details on this search FlashKit forums
http://www.flashkit.com/board/search.php?& action=showresults& searchid=941512
Just to add to the above.

The applescript must be saved as an application, set to ‘run only’, and with the extension visible. It is
handy to keep the filesin the ‘fscommand’ folder, so you must call it too:

tell application "Finder"
activate
select file "your_file.pdf" of folder "fscommand" of disk "Your_CD_image"
open selection

end tell

Savethis as, for example, ‘your_applescript.app’

and the button code must read:

on (release) {
fscommand("exec", "your_applescript.app");

}

106. Does the JMAPI tool work for Lotus Notes R5 which is not MAPI compliant ?
No JMapi only supports email clients that are MAPI compliant.

107. I'm having problems reading the JMV.ixt to retreive the status of the Movie, using JMovie and
Jugglor together. Can you help ?

Yessure.
Use the LoadV ariables command to load the text file

i.e
loadV ariables("IMV .txt", this);
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Also read

JMovie Help File -> Additional Features -> Retrieving status with IMV .txt
P ease download the example file provided.

108. How do | create a photogallery using Flash ?
Hereisagreat tutorial.

http://www .kirupa.com/devel oper/mx/photogallery.htm

109. What is Jugglor?

Jugglor turns Projector filesinto full-fledged programs. It modifies existing projector files by making the
projector file full screen, makes the escape key the key to exit the file, changes the icon for the file and

disables the menu that comes up when you right click. It then packagesthis all up again into an EXE and
aDLL.

Read more about the features here :

http://www.jugglor.com

110. I am having problems using the MainRatio and selecting a print area using Flash MX. | need
some help.

Please take alook on the example file provided. It includes all the sourcefile.
Remember to extract all the filesin the default directories.
111. Is there are Mac verion of JWeb ?
You really don't need to use a Mac version just use
getURL ("http://www.flashjester.com™)
but if you are facing some problems, you can use Applescript
set theURL to "http://www.flashjester.com.com"
teII_ application "Finder"
activate

open location theURL
end tell

112. How can a READ variables from My Documents folder ?
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Y ou need to use the MY DOC% commmand

which will give you accessto

C:\Documents and Settings\UserName

Look at example file provided and please read the

JSave Help -> Setting up JSave -> Additional Commands

113. Is there a Mac version of JEmail ?

You better off using the getURL (mailto:support@flashjester.com) but if this doesn't work you can use
AppleScript

open location "mailto:someone@somewhere.com”
114. How can | add copy protection to my Projector files ?
Take alook at
PC Guard for Win32 on http://www.sof pro.com/
their software works with Juggled files.

It gives you MUCH more control and security features you can ever imagine.

115. I show my Flash documents via the Flash projector (.exe) on a classroom screen using a Dell
AV projector. So there is no acess to the Web and programming a popup window with a URL will
get me nowhere. Instead, I'd need to launch window content | have prepared in advance.

Can JProWeb find a document on my hard drive or does it only accept URL's, and if so, is there a
"work-around" this?

Y es sure you can load local html files using JProwWeb
Download an evaluation copy from
http://jproweb.flashjester.com

See the following examples

Standalone
C:\Program Files\FlashJester\JT ool s\JProwWeb\Mx\Example 1

With Jugglor
C:\Program Files\FlashJester\JT ool s\JProwWeb\Mx\Example 2
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Read the help file also
C:\Program Files\FlashJester\JT ool s\Source\JProWeb.hlp
Setting up a JProwWeb Command

Hope this helps.

116. Is it right that JSave can only write 255 charachters to a text file?
Yesitislimited by the length of the command line.

We recommand our latest JTool called JSystem.
http://jsystem.flashjester.com

It has a command called

SaveToFile

which has no limit to the size.

JSystem Help -> FSCommand List -> File Manipulation -> SaveToFile

Thiswill help

117. 1 was trying out your JWeb and wondering if there is anyway to set the browser window to open
maximized?

Yesitis.

Y ou will have to use JStart and the /maximised command.

Download an evaluation copy from

http://jstart.flashjester.com

and then look

C:\Program Files\FlashJester\JT ools\JStart_JWeb_JEmail.hlp

JTools Settings -> JStart - Opening afile Maximised...

In the File paramater add the URL instead of afile name.

118. What are Flash Tools ?
Flash Tools are third party softares that give you that extra functionality and customisation to the Flash
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SWF format. We provide such tools.
Y ou can find other such tools here
http://www.swftools.com

119. What does SWF to EXE mean ?

Basically it means converting your SWF to an application that can be run on any machine. These are
usually called Projector files.

To do thisin Flash you would go to
File -> Publish Settings

The advantage in using a Projector file isthat it has the Flash Player built inside it. So you don't have to
worry about end users not having the flash player install. Minimise the extra support for your clients.

120. How can | play a Macromedia Flash animation in PowerPoint?
Please read this
http://office.microsoft.com/en-us/assi stance/HA 010348071033.aspx
and
http://www.ellenfinkel stein.com/powerpoint_tip.html#flash
121. How can | open a new window like a popup from a Flash file inside a html file ?
Visit... http://www.flash-db.com/PopUp/
Create the window with the features you want or don't want!, generate the code, and simply copy &

paste the generated code on your Flash button. No html stuff envolved here. Everything's in the Flash
movie.

122. How can | put carriage returns into a text file using JSystem -j:sy:savetofile command ?
Simple add the chr(13) to your variable
i.e
TheString="Linel'+chr(13)+'Line2'
or ashorter way to insert new lineis:
TheString="Linel\rLine2’;

See the exampl e file below.
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123. Here are some additional tips when using JStart provided by Joe B.
Thanks
1) Publish asa EXE not SWF. SWF or CTRL+ENTER emulation will not work.
2) Do not include path (c:\fscommand\...) in the fscommand to launch the executable.
3) Do not include path (c:\fscommand\...) in the "Application=" statement of theini file.
4) EXE that you publish should bein the parent of the fscommand directory.

124. How do | find out the CD-Rom Drive letter because my links work on hard drive, but not when |
put it on CD?
Y ou need to use JStart with parameters and rather than defining a full path (e.g. D:\files\mymovie.mpg)
you need to put in the relative path (e.g. if your JStart and SWF are in D:\ , youd use
"filesmymoviempg"). If you are using Jugglor, try using the Current Directory feature or you can use
the LOCAL% command (see Jugglor Help file -> Tips).

125. | brought JStart and have successfully used it in my Flash MX movie to launch a PDF within its
application and also another .exe file. However, this CD needs to be cross platform. | know that |
can build an "applescript" that | can launch from an fscommand in Flash (although I'm not all
together sure what Applescript is or how to use it....). However, what | wonder is, how would that
affect my button? Would | have to run some sort of automatic test of the user's computer to see
whether they're using Mac or PC before the flash movie even launched? | just wondered how I could
have both of the fscommands in my Actionscript: Like "Do this if they have a PC, and do this if they
have a Mac." Is that possible? I'm really not too good with Actionscript.

You will have to create 2 different FLA's one for the Mac and PC and publish them as Projector files.
The PC FLA with JStart commands and the other with Applescript as described below.

http://www.flashjester.com/?section=fag& cPath=28 41#232
For creating a hyrid CD and Autoruns for both platforms read this

http://www.flashkit.com/board/showthread.php?s=ffal834a93eabd8f 5¢c4c8f9e97f 34191& threadi d=5003
26

Hope this helps.

126. Do you offer any custom solutions?

We can create and produce a screen saver to your specifications and requirements. Please contact us for
more detail s on support@flashjester.com

127. Can | use the copy and paste commands in Flash using Actionscript? We want to copy text in
the clipboard and paste it in the Flash file?

Y es sure this possible.
See you can use the

CopytoClipboard
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and

GetFromClipboard

See

JSystem Help -> FSCommand List -> File Manupulation -> CopyToClipboard / GetFromClipboard

See the exampl e file below

128. How | could create copy and paste buttons for input text fields (as some novice users of
software would not think to use ctrl+c / p or right click copy/paste)?

Flash Actionscript doesn't support this. Y ou can use our JTool - JSystem to do this.
See
JSystem Help -> FSCommand List -> File Manupulation -> CopyToClipboard / GetFromClipboard

Look at the example file provided below.

129. What is the best way to optimise flash to video ?
FlickerLab have written a very good article on this.

Click on
http://www.flickerlab.com/flashtovideo/
130. | want to read all the files names from a given directory in Flash Projector. How can | do this ?
Y ou can use JSystem to read a folder and much more.
Download an evaluation copy from
http://jsystem.flashjester.com
Then read the JSystem Help file
Home > Command -> ReadFolder
look at the example files provided.

131. How can | reduce the size or optimize the size of my SWF ?
Please look at the following tools
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Flash Optimizer
http://www.flashoptimizer.com

Sparkle SWF Optimizer
http://www.flashkeeper.com/so.htm

Swift Optimizer
http://www.swishsoft.com/swiftoptimizer.htm

Optimaze!
http://www.erain.com/products/optimaze/
132. How can | create a Flash MP3 player ?

Please visit this website, it gives you an indepth tutorials how to do this.

http://www.kennybellew.com/tutorial/

133. How can i browse SWF file in Windows Explorer in the thumbnails view ?
SWF Live Preview 1.0

SWF Live Preview is amed to help you preview Macromedia Flash files using standard built-in
Windows Explorer. Excellent design, easy-to-use interface, powerful features and unique capabilities
make SWF Live Preview indispensable application. And it is free of charge! You won't find anything
similar!.
http://www.eltima.com/downl oad/swf-live-preview/

134. When | execute JSAVE does the function return a value to show it is finished? ResultVar?
No JSave cannot do this.
BUT you can look at JSystem - SaveToFile command.
http://jsystem.flashjester.com
Download the evaluation copy and look at the help file.

135. How can | keep all these JProWeb and html files into one EXE ?

Please read this

http://www.flashj ester.com/index.php?section=fag& cPath=14 56 74

136. How do you make those litte icons in the address bar, you know to the left of where you put the
address?
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Take alook here

http://www.favicon.com

137. Is it possible to build dynamic JSTART statements. For instance | have a number of different
.pdf's that are opened from different sections in my flash app. It would make my life much easier if it
were possible to build a function on my _level0 movie to run a JISTART command and just pass the
file name when calling the function.

i.e.: function openDoc(docName){

fscommand ("exec", "JSTART"+ docName +" /error=error");
Yesit'spossible, you will need to use JStart with Jugglor.

Read this

http://www.flashjester.com/index.php?section=fag& cPath=14 56 26#282
138. How can | use JPrintor and Jugglor together?

Take alook at this section

http://www.flashjester.com/index.php?section=fag& cPath=14_47

139. What can Jugglor be used for?

There are many different uses for FlashJester Jugglor. By clicking below you can see alist of possible
uses for Jugglor.

http://www.flashjester.com/index.php?section=tricks jugglor_jugglor30plus
140. Do you have any Flash Tips ?

Y es go to Macromedia Support Area

http://www.macromedia.com/support/

Kirupa
http://www .kirupa.com/

FlashKit
http://www.flashkit.com

We recommend you also to our links section

http://www.flashjester.com/index.php?section=links
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141. How do you configure Creator for a silent install ?
We have tried (Creator -> Build -> Top Left -> Uncheck all expect for Welcome, Destination and
Message Dialog) but it won't let us uncheck the Welcome Page and Message Dialogs.

Y esthisis not possible with Creator, you will have to use another third
party installation to create asilent install.

Read the following
http://www.flashjester.com/index.php?section=fag& cPath=6_10
and here arelist of FREE Installers
http://www.flashjester.com/index.php?section=fag& cPath=50#225

or if you have Wise or Installshield you can use them.

142. On one machine when | use JProWeb it opens up the notepad instead of the browser with all
the JProWeb settings ?

Check isthefile association of *.HTA and *.HTML files, thisis what JProwWeb uses too.

Y ou should open thisfile with |E .

143. Why doesn't the following flash exec fscommand work ?

fscommand(“"exec","mydoc.pdf")
Flash Exec Fscommand only supports EXE's and no other type of extension. You can use JStart to
overcome this problem.

Try it

http://jstart.flashjester.com

144. 1 would like to use the In-Memory file support in Jugglor, where | can hide the text file in
memory away from the user, now can | load that file using JSystem and the LoadfromFile command
?

Yesyou can, you just add the prefix
INMEM %,

S¢)

"Filename"

will be

"INMEM %Filename"
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145. Does Creator support Dual Monitor ?
Not currently, the new version 2.0 will support dual monitor.

146. 1 am having problems carriage returns and linefeeds with JSave ?
We found the problem.
After tracing the encoded string, it converted it into_d and _a.
Looking at the EncodeForJugglor function, :
s=ord(c).toString(16);
if (ord(c)<10) s='0'+s,
Result +=" '+s,
Te second line should be: if (ord(c)<16) s='0'+s;
SO
s=ord(c).toString(16);
if (ord(c)<16) s='0'+s,
Result +=' '+s;
We have updated the Jugglor and JSave Help file.
147. 1 need help using Jugglor and JMapi together to generate an email sent to an address entered

by the user using a form the Projector file AND attaching a document.

Is there a way to use the JMapi tool that will allow sending an email attaching a document but
allowing the user to enter the email address with a form (located in the Projector file)?

Yessurethisis possible.
Please look at the example file below.
148. How can | convert my Powerpoint Presentations into SWF files ?
Flash Spring
http://www.flashspring.com

Open Office - Impress - FREE
http://www.openoffice.org/

IceSlide
http://www.iceweb.com
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PowerConverter
http://www.presentationpro.com/products/powerdelivery/PowerCONVERTER.asp

149. How do | convert my Flash movie to a DVD ?
Y ou can use Macromedia Director
Read this
http://www.macromedia.com/devnet/mx/director/articles/flash_dvd.html
150. How do i open a word or pdf document from my flash file thats on my website ?
Use
getURL ("your word or pdf document path”, " _blank™);

That'sit, no extratools required.

151. | have 2 Excel documents that | am putting on a Flash CD with about 20 Word and 40 PDF
documents. Everything works fine except the 2 Excel documents don't open. Excel starts up but |
get a

"filename.x|s" could not be found.'

error.

| can open the file by clicking on the file and | have double checked the spelling and location.

JSTART.exe "/Financial_Forms/document.pdf"

Are there any special problems with .xls documents?

Y ou have forward slashes, you should always use BACKWARD SLASHES
i.e
JSTART.exe "\Financial_Forms\document.pdf"

That will do the trick.

152. How do | use JSave to save more than one variable and then how by using loadvariable
command to split and get them to load them?

Here

Variablel=xyz& Variable2=abc& etc.
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Then the loadvariable command will split them automatically
153. How do | change the Flash Cursor or something people call it the Flash Pointer?

First of all create the image you want and save it asan mc cal it "my_cursor"”.

Then drag an instance of this mc just off the side of the stage and give it an
instance name of "my_cursor”

Copy the following code into the first frame
Mouse.hide();
my_cursor.onMouseMove = function() {
this._ X = _Xmousg;
this._y = _ymousg;
updateAfterEvent();
¥

We is aposted example-
http://www.nepeanmedia.com.au/flash/flas'my_mouse flash_8.fla
154. How to a convert my Flash SWF file to Video ?
Hereis an excellent site that describes how to convert the SWF to Video
http://www.flickerlab.com/flashtovideo
155. Do you have any Flash Tutorials for me ? | am a beginner
We don't but these guys certainly do
http://www.sephiroth.it/tutorials.php
http://www.actionscripts.org/tutorials.shtml
156. How do | use Flash to connect to mySQL ?
Read these
http://www.webmonkey.com/webmonkey/programming/php/tutorial s/tutorial 2.html
http://www.actionscripts.org/tutorial s/beginner/Integrating_Flash_and_mySQL/index.shtml

http://www.sephiroth.it/tutorials.php

157. 1 am having problem using JProWeb. i get the following error
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"This file does not have a program associated with it for performing this action. Create an
association in the Folder Options control pane.

158.

159.

Check that the file association of *.HTA and *.HTML files, thisis what JProWeb uses too.
Y ou should open thisfilewith |IE .
Windows Explorer -> Tools -> Folder Options-> File Types-> HTM Application

How can | print a document i.e Word, PDF or Text file?

You can use the /Print command that comes with Start it prints any document that supports DDE
printing.

Please read

JStart JWeb JEmail Help File-> JTool settings -> JStart - Using the Print Command
and download the example file given.

How do | print a PDF file from Flash Projector ?

JPrintor will not do this. Y ou need to use JStart please follow this link

http://flashjester.com/?section=fag& cPath=28_41#352

160. Can JStart and Flash MX or Flash 8 work with Jugglor ?

161.

Y es sure you can.

http://www.flashjester.com/?section=fag& cPath=14_26

How do | Launch Windows Explorer to open at a certain folder and drive ?

Y ou will need to use JStart

1. Create anew JStart link in JHel por

2. Select "Use parameters’

3. Inthe File box type WIN%\EX PLORER.EXE. This declares the program to be run

4. In the Arguments box type in location that you want Explorer to open up in eg. d:\temp

When JStart is then run using these parameters, it will run Windows Explorer with the directory
D:\Temp in the main view.

Now if you wanted to open up Windows Explorer in the current directory where the Projector file
residesi.e in the CD-ROM or a sub-directory on the CD-ROM then you will have to use Jugglor along
with JStart.

1. Download Jugglor from http://www.jugglor.com
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2. Create the new JStart link in Jugglor - JTools
3. Select "Use parameters’
4. In the File box type WIN%\EXPLORER.EXE. This declares the program to be run
5. In the Arguments box typein LOCAL% (if in asub directory i.e subl then use LOCAL %subl)
6. Copy and paste the command into the Flash FLA file.
7. Export the SWF and then patch it (Jugglor - JTools - Patch Movie).
8. Create a Projector file and assign thisin Jugglor - Flash Details - Flash Projector file
9. When you press build it will compile ONE Juggled file containing JStart and the Projector file. So all
you haveto do is distribute onefile.
We recommend you download the sample file from
162. Why don't the zip file links to your downloads don't work on Firefox?
Thisisthefirefox bug. It can't read zip files. However, all other files download fine.
Y ou must download and install addon
https://addons.mozilla.org/extensions/morei nfo.php?application=firef ox& category=Popul ar& numpg=10
&id=201
to fix this problem.

After installation, restart firefox and load page again. Right click on the link and select Save Link with.

163. | am having problems saving text to my XML file using JSave. Seem | am having problems with
the double quotes.

Pease download the following example file. This example does exactly this.

164. | need help using JProWeb. | need to open a borderless window url from a Projector file ?

First of all read the help file given.

Start -> All Programs -> FlashJester -> JTools -> JProWeb -> JProweb Help
Setting up JProweb Command -> Setting up for Flash MX

Follow the step by step.

Then look at the example files given

C:\Program Files\FlashJester\JT ool s\JProWWeb\M x

Also read the online FAQ

http://www.flashj ester.com/index.php?section=fag& cPath=28 49
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Hope this helps.

165. The code works just fine in v2.1, | don't know if it's because of the version change or what.
This is our code :
MakeXMLMap();// our function to make xml content=gXMLDoc.toString(); //make

a string out of our xml document //write it down to temp.xml
fname="temp.xml";

fscommand("exec",EncodeForJugglor(’j:sy:savetofile:"+fname+","+content+
,Resultvar'));

Is there something wrong with this code or is the new version clash with Jsystem? Other
functionality of Jsystem works just fine (Save/load dialog)

Each " symbol in the content must be encoded with two " symbols, because one symbol will terminate
the string.

166. | have a main projector file. Now | want to use addtional SWF's to load my web pages and links
with JProWeb. Is this possible ?

Yesit sureis.
See the example below.

Please please please. Go through the 2 FLA's files so you can understand how it all works. Look at the
directory structure and why its that way.

167. | get the following message on my Flash web page.
"Click to activate and use the control"

How can i remove it ?
Read thisfor all your answers

http://www.amarasoftware.com/flash-problem.htm
or

http://activecontent.blogspot.com/

168. How do a convert my DVD to Flash FLV ?
To turn your DVD into a Flash FLV then following these instructions.

1. Copy the .VOB files from your DVD to your hard drive. DVD video
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iIsMPEG, so change the file extension to nameofvobfile MPG.

2. Use this freeware software called DV Dx.
DVDx alows you to convert your own DVD to VCD2.0/SVCD1.0/AVI/ WMV
in one step (Including multiplexing, splitting). It produces very
good quality moviesin AVI/MPEGLYMPEG2/WMV 9 format and you don't
need to have 5GB free on your hard disk !

Download it from here

http://prdownloads.sourceforge.net/dvdx/DVDx_2 5 1 setup.zip?download

3. Openin Flash 8 Video Encoder, create flv file.

169. | have a Flash Projector EXE file, | don't have the oringal FLA, is there anyway to recover the
SWEF from the EXE ?

EXE to SWF ?
Y esyou can.

Look at these tools

SWF2EXE
http://www.flashkeeper.com/fk/swf2exe.htm

SWF Scanner
http://www.livetronix.com/products/swfscanner/

170. 1 am looking for a method to print (whether it be a local file, or a frame in Flash) from a Flash
projector. The project | will be using this for will be a Kiosk which will print maps to a local printer if
the user so chooses.

The application | am building will be a fullscreen Flash application and we would like to bypass the
printer dialogue box when the user touches the "Print" button within the Flash app. (ie. Press button
once > Out comes a page)

Does JPrintor allow me to do this?
For Local File Printing

We recommend you use JStart with the /print command. This will print a doc or pdf file without any
dialog boxes.

Read this

http://www.flashjester.com/?section=fag& cPath=28 41#352
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and look at the examplefile given.
Frame Printing

To print a screenshot then use JPrintor. It will by pass the Printer Dialog, just make you don't have this
option checked

Other -> Show Printer Dialog

171. How do | open a powerpoint presentation file *.pps using a Flash Projector file?
Y ou can do this using JStart.

http://jstart.flashjester.com

See the exampl e file beloiw

172. We are having problems opening a Powerpoint File pps or ppt file in a Flash Projector using
JStart.

We get the following error

"This file does not have a program associated with it for performing this action. Create an
association in the folders options control panel.”

| have installed the Powerpoint 2003 Viewer on this machine which doesn't have Office 2003 -
PowerPoint. On the other machines with Office 2003 it works fine.

Thisis a PowerPoint Viewer issue and not a JStart.

The installation doesn't add the PPS or PPT file association in the folders option in the Control Panel.
Y ou have to-do this manually.

Read thisif you want to do this

http://ask-leo.com/what_does this file does not_have a program_associated with it_mean.html
But this doesn't make sense as you can't do thison all your clients machines.

So we need to find a workaround.

PowerPoint had an option called 'Package for CD'

1. Open the PPS file you want on the CD.

2. PowerPoint -> File -> Package for CD

3. Copy to Folder..

4. Change the nameif you want.
5. Press OK.
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Then copy the folder if just created. i.e.

My Documents\PresentationCD

to you working folder.

You will notice that in thisfolder it has ALL the files you require to open a PowerPoint file regardless to
whether the end user has PowerPoint. The PowerPoint viewer filesare al here.

Double click on the play.bat and you will see it open up.

Now you need to go to the JTools section in Jugglor and use JStart. There are 2 methods which we can
use:

1. Open the bat file play.bat
2. Construct the command line in JStart that opens the viewer and PowerPoint file

i.e pptview.exe /L "playlist.txt"
Open Jugglor.

Jugglor -> JTools -> + -> JStart
Use Parameters

Method 1.

File
local %PresentationCD\play.bat

Default Directory
|ocal%PresentationCD

Method 2

Now if you don't want to see the MS-DOS black box appear before the presentation starts then we an
eliminate the use of the bat files so we have

File
local %oPresentationCD\pptview.exe

Arguments
/L "playlist.txt"

Default Directory
|oca %PresentationCD

REMEMBER : PresentationCD isthe folder where all the PowerPoint files are.
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That's it.

Press the OK button and Close the JTools window.
Press the bottom Copy button next to the Arguments edit.

The paste thisinto your FLA file.
It will look something like this.
1.

on (release) {
fscommand("Exec”,

"JSTART _20local_25PresentationCD_5Cplay.bat 20 20 2Fdir_3Dlocal _25PresentationCD");
}

2.
on (release) {
fscommand("Exec",

"JSTART_20local_25PresentationCD_5Cpptview.exe 20 _2FL_20_22playlist.txt 22 20 2Fdir_3Dlocal
_25PresentationCD");

}

Publish it and bring it into Jugglor and Build the project.

Now if you have mutliply PowerPoint files, then you don't need to create another folder with the view
inside, but just another playlist.txt file and change the name of the PowerPoint file inside it.

i.e
playlist2.txt

insideit just has
FlashJester2.pps

Please please download the example file to see if working. It has all the source files you require.

173. How do | use JSave and XML in my Flash Projector ?

We've added as much power as we can to JSave with all the features we have put into it but at the end of
the day it isatool to help your creativity and do with it what you wish. And that is exactly what Nicolas
S Roy, Interactive Developer for Logient (www.logient.com) did.

Using our JSave example file that comes packaged with JSave, he modified it to save XML files on the
hard drive!

He has also kindly given us the code so that you can implement it in your Flash files!
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function jSave (srcText, fileName) {

/I Thisisthe procedure that

/] saves the text

x="1"

y="1%

/] srcText isthe text you want

/ to save

tempstr = srcText;

z = length(srcText);

result ="";

Load = z;

while (Number(x)<=Number(2)) {

if (substring(tempstr, x,y) eq" ") {

result = result + " 1";

X = Number(x)+Number(y);

} eseif (substring(tempstr, X, y) eq chr(10)) {
result = result + "%CR";

X = Number(x)+Number(y);

} eseif (substring(tempstr, X, y) eq chr(13)) {
result = result + "%CR";

X = Number(x)+Number(y);

} else{

result = result + mbsubstring(tempstr, X, 1);

X = Number(x)+1,
}

}

X=X;

y=y

r = result;

Il SaveFileisthefile nameyou

// want to save the text as.

r2 ="jsave.exe" + mbchr(9) + fileName + ".txt" + mbchr(9) + "srcText=" +r;
fscommand ("Exec", r2);

}
}

174. Will | have to include a copy of JAvi for each Avi | open with it?

Yesthat is correct. For each movie you have you will have to create ajavi.exe and javi.ini.
Now if you have 100+ thisisnot agood solution.

To avoid this you can use Jugglor and JAvi together, where it will only require 1 copy of Javi.exe which
Jugglor automatically adds to the final exe.

With Jugglor you have a choice whether you want to

1. Keep the avi filesinside the final Juggled file
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2. Keeo them outside the Juggled file where you will have to use the local% command. See

JAvi Help -> Flash Support -> Using the LOCAL % command

See the example below.
For more information on Jugglor go to
http://www.jugglor.com

175. Do you have a SWF to FLA tool ?
Look at
Sothink SWF Decompiler MX 2002 Pro
http://www.sothink.com/flashdecompiler/index.htm
Sothink SWF Decompiler MX 2002 Pro is a tool to browse, view and parse Shockwave Flash movies
(.swf files). It can extract sounds, images, movie clips from a Flash movies. What's more, SWF
Decompiler can decompile the action scripts in a Flash movie and turn them into neat and readable code.
New version supports Flash MX format
and
IMPERATOR FLA generates FLA-files (readable with Flash MX(6) or higher) from the selected input
SWFs (compiled with Macromedia Flash) and thereby makes it possible to alter the content of a SWF
even when the corresponding FLA got lost. Furthermore it gives you the opportunity to extract al
included media-files (pictures, sounds and videos) so you can edit them with other programs.
http://ave-imperator.com

176. Can | recover my FLA from a SWF file ?
Y es you can well part of it.
Read this
IMPERATOR ?FLA generates FLA-files (readable with Flash MX(6) or higher) from the selected input
SWFs (compiled with Macromedia Flash) and thereby makes it possible to ater the content of a SWF
even when the corresponding FLA got lost. Furthermore it gives you the opportunity to extract al
included media-files (pictures, sounds and videos) so you can edit them with other programs.
http://ave-imperator.com

and

Sothink SWF Decompiler MX 2002 Pro
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http://www.sothink.com/flashdecompiler/index.htm

Sothink SWF Decompiler MX 2002 Pro is a tool to browse, view and parse Shockwave Flash movies
(.swf files). It can extract sounds, images, movie clips from a Flash movies. What's more, SWF
Decompiler can decompile the action scripts in a Flash movie and turn them into neat and readable code.
New version supports Flash MX format

177. When | double click on a Flash SWF file on my PC nothing happens ?
I've installed the latest Flash Player but still nothing.

It works fine on Internet Explorer
There are 2 things you can do here.

1. Publish the SWF file as a Projector file using Flash.
2. You will need have SAFlashPlayer.exe which actually comes with Flash and plays the Flash file.
C:\Program Files\Macromedia\Flash XX X\Players\Release

Double click on this and then close it. Now your SWF files will be assigned to the SAFlashPlayer.exe
you clicked on.

If you want to load SWF's file in different Flash Players i.e. MX, MX 2004 or 8 then find the
appreciated SAFlashPlayer.exe.

Below you will find alink the Flash 8 - SAFlashPlayer.exe

178. What tool can we use for an installer?

Inno Setup is by far the easiest installer to use. You can go from installing it to having your installer
done i